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ЛАБОРАТОРНАЯ РАБОТА №1 
 

АРХИТЕКТУРА И СИСТЕМА КОМАНД МИКРО-
КОНТРОЛЛЕРОВ PIC16F87X И ОТЛАДОЧНЫЕ СРЕДСТВА 

ФИРМЫ MICROCHIP 
 
Цель работы: Изучение архитектуры и системы команд вось-

миразрядных однокристальных микроконтроллеров фирмы MI-
CROCHIP семейства PIC16F87X, знакомство с отладочной средой 
MPLAB и отладочным модулем MPLAB-IСD Demo Board. 

 
1. АРХИТЕКТУРА И СИСТЕМА КОМАНД МИКРО-

КОНТРОЛЛЕРОВ PIC16F87X 
 
Основные особенности архитектуры высокопроизводительных 

восьмиразрядных однокристальных микроконтроллеров PIC16F87X: 

АЛУ: 
− высокоскоростная RISC архитектура арифметико-

логического устройства; 
− 35 инструкций; 
− прямой, косвенный и относительный способы адресации; 
− все команды выполняются за один командный цикл (4 такта) 

кроме инструкций переходов, выполняемых за два цикла; 

− тактовая частота 0 – 20 МГц. 
ПАМЯТЬ: 
− 8192 14-разрядных слова памяти программ, выполненной по 

технологии FLASH (электрически стираемой ПЗУ); 
− 368 8-разрядных байт памяти данных (ОЗУ); 
− 256 8-разрядных байт памяти данных (электрически стирае-

мое ПЗУ). 

ПЕРИФЕРИЙНЫЕ МОДУЛИ: 
− система прерываний (до 14 источников); 
− 8-уровневый аппаратный стек; 
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− сторожевой таймер WDT с собственным RC генератором; 
− режим энергосбережения; 
− программный выбор параметров тактового генератора; 
− 33 линии цифрового ввода-вывода (порты A – 6 разрядов; B, 

C, D – 8 разрядов; E – 3 разряда; 
− повышенная нагрузочная способность портов ввода-вывода 

(25 мА); 
− таймер 0: 8-разрядный таймер/счетчик с 8-разрядным предде-

лителем; 
− таймер 1: 16-разрядный таймер/счетчик с возможностью под-

ключения внешнего резонатора; 
− таймер 2: 8-разрядный таймер/счетчик с 8-разрядным предде-

лителем и выходным делителем; 
− два модуля сравнения/захват/ШИМ (CCP): 

o 16-разрядный захват (максимальная разрешающая способ-
ность 12.5 нс); 

o 16-разрядное сравнение (максимальная разрешающая спо-
собность 200 нс); 

o 10-разрядный ШИМ; 
− многоканальный 10-разрядный АЦП; 
− последовательный синхронный порт MSSP: 

o ведущий/ведомый режим SPI; 
o ведущий/ведомый режим I2C; 

− последовательный синхронно-асинхронный приемопередат-
чик USART с поддержкой детектирования адреса; 

− ведомый 8-разрядный параллельный порт (PDP) с поддерж-
кой внешних сигналов –RD, -WR, -CS; 

− детектор пониженного напряжения питания (BOD). 
Структурная схема микроконтроллера PIC16F788 приведена на 

рис.1.  
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Рис. 1. Структурная схема микроконтроллера PIC16F788 
  

1.1. Организация памяти программ 
 
 Семейство PIC16F7X имеет 13-разрядный счетчик команд, с 

помощью которого адресуется пространство 8К×14 памяти про-
грамм. После начальной установки программный счетчик устанав-
ливается на 0000h, а любое прерывание вызывает переход на адрес 
0004h. Инструкции переходов (CALL и GOTO) имеют 11-разрядное 
поле для указания адреса, что позволяет непосредственно адресовать 
2К слов памяти программ. Для адресации верхних страниц памяти 
программ используются 2 бита регистра PCLATH<4:3>. Перед вы-
полнением команды перехода (CALL или GOTO) необходимо зане-
сти в соответствующие биты регистра PCLATH адрес требуемой 
страницы. При выполнении инструкций возврата из подпрограммы 
13-разрядное значение для счетчика программ PC считывается из 
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вершины стека, поэтому манипуляция битами регистра 
PCLATH<4:3> не требуется. Организацию памяти программ поясня-
ет рис.2. 

 

 
 

Рис.2. Карта памяти данных 
 

1.2. Организация памяти данных 
 
Память данных разделена на четыре банка, которые содержат 

регистры общего и специального (SFR) назначения. Биты RP1 и RP0 
(регистр STATUS соответственно биты 6 и 5) предназначены для 
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управления банками данных. Ниже показано состояние управляю-
щих битов при обращении к банкам памяти данных: 

 
RP1:RP0 Банк 

00 0 
01 1 
10 2 
11 3 

 
Объем одного банка памяти составляет 128 байт (7Fh). В начале 

каждого из банков размещены 32 8-разрядных регистра общего на-
значения. Остальные 96 регистров текущего банка используются 
пользователем как статическое ОЗУ данных. Некоторые, наиболее 
часто используемые регистры специальных функций, отображаются 
в банках памяти данных. Карта памяти данных применительно к 
PIC16F788 приведена на рис. 2. 

 
1.3. Регистры специальных функций 

 
С помощью регистров специальных функций выполняется 

управление функциями арифметико-логического устройства и пере-
ферийными устройствами. Эти регистры реализованы как статиче-
ское ОЗУ. Основные сведения – адрес, уникальные имена регистров 
и отдельных битов, а также состояние после сброса приведены в 
приложении 2. 

 
1.4. Стек 

 
Микроконтроллеры семейства PIC16F87X имеют 8-уровневый 

13-разрядный аппаратный стек (рис. 3). Стек не имеет отображения 
на память программ и память данных. Значение счетчика команд за-
носится в вершину стека при выполнении инструкции перехода или 
обработки прерывания. Обратное чтение из стека в счетчик команд 
происходит при возвращении из подпрограммы или процедуры об-
работки прерываний. Стек работает как циклический буфер. После 8 
записей в стек девятая запись заменяет первую. 
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Рис.3. Аппаратный стек микроконтроллеров семейства PIC16F87X 

 
2. СРЕДСТВА ОТЛАДКИ 

 
Наиболее простым и функциональным инструментом для разра-

ботки программного обеспечения микроконтроллеров PICmicro яв-
ляется интегрированная среда разработки MPLAB-IСD фирмы MI-
CROCHIP. MPLAB-IСD позволяет создавать/редактировать текст 
программ, преобразовывать текст программ в исполняемый код, а 
также осуществлять отладку и оптимизацию выполняемого кода. 
MPLAB-IСD включает в себя: 

менеджер проекта MPLAB, используемый для создания и рабо-
ты с файлами, относящимися к проекту; 

редактор MPLAB, предназначенный для написания и редактиро-
вания исходного текста программы, шаблонов и файлов сценария 
линкера; 
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MPLAB-SIM симулятор, программно моделирующий выполне-
ние программы в микроконтроллере; 

MPLAB ICE эмулятор, обеспечивающий управляемую работу 
микроконтроллера в масштабе реального времени непосредственно в 
устройстве пользователя; 

MPLAB ассемблер/компилятор/линкер/редактор библиотек, 
компилирующий (преобразующий в исполняемый код) текст про-
граммы, связывая различные модули и библиотеки; 

программаторы PRO MATE и PICSTART plus, предназначенные 
для программирования встроенной FLASH-памяти программ микро-
контроллеров. 

2.1. Начало работы с MPLAB-ICD 

Рассмотрим работу в среде на основе конкретного примера. Ра-
бочий стол среды состоит из (рис. 4): 

1. Главное текстовое меню. 
2. Графическое меню. 
3. Рабочая область. 
4. Линейка состояния. 

 
Рис. 4. Рабочий стол среды MPLAB-ICD 
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Выберите пункт Options > Development Mode, нажмите кнопку 
Tools для выбора инструментального средства и типа микроконтрол-
лера, используемого в проекте (рис. 5).  

 
Рис.5. Окно выбора инструментального средства отладки 

 
Выберите в окне Tools симулятор MPLAB SIM и микрокон-

троллер PIC16F877. Теперь, когда симулятор инициализирован, в 
линейке состояния включатся индикаторы “SIM” и “PIС16F877”. 

2.2. Создание нового проекта 

Симулятор работает с кодом программы (файл с именем, задан-
ным пользователем, в дальнейшем – <name> и с расширением 
.HEX), который, в свою очередь, генерируется из текста исходного 
текста программы компилятором. 

Выберите пункт меню File > New, и на экране появится сообще-
ние (рис. 6). 

 
Рис. 6 
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Нажмите Yes и увидите следующее диалоговое окно (рис.7). 

 
Рис. 7. Окно выбора файлов 

 
В этом окне необходимо указать имя файла проекта и его место-

положение. Подтверждение имени файла проекта приведет к сле-
дующему диалоговому окну (рис. 8).  

 

 

Рис.8. Окно редактирования параметров проекта 
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Нажав кнопку Add Node, вы увидите стандартный диалог выбора 
файлов (рис. 7), но уже применительно к файлу с расширением 
.ASM, содержащему текст программы на языке Ассемблера. Введите 
имя файла <name>.asm и нажмите OK. Вы вернетесь к окну редак-
тирования параметров проекта, где ниже файла кода <name>.hex 
должен появиться файл исходного текста программы <name>.asm. 
Нажатие кнопки OK вернет Вас на рабочий стол среды MPLAB-ICD 
к открытому, но еще не названному файлу текста программы. 

2.3. Создание нового исходного файла 

Поставьте курсор в любое место открытого файла, выберите 
пункт меню File > Save As..., укажите имя и место расположения 
файла текста программы <name>.asm и нажмите OK. Имя исходно-
го файла должно совпадать с именем проекта. 

2.4. Ввод исходного текста программы 

Расположите курсор в начале файла <name>.asm. Введите сле-
дующий текст: 

listp=16f877 
include<p16f877.inc> 
c1 equ  0x0c  ;адрес переменной c1 – 0x0c 
  org  0x00  ;установить начало программы в век- 

       тор сброса 0x00 
  nop 
reset 
  goto  start  ;переход на начало программы 
  org  0x04  ;начало размещения программы в па- 

        мяти 
start 
  movlw  0x09  ;установить значение счетчика 
  movwf  c1  ;записать его в регистр счетчика 
loop 
  incfsz  c1, F  ;инкремент счетчика и пропуск  

         следующей команды 
       ;если результат равен нулю 
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  goto  loop  ;продолжить 
  goto  bug  ;переинициализировать счет 
  end 
Обратите внимание на синтаксис текста и расположение меток, 

директив и комментариев. Подробное описание директив смотрите в 
документации MPASM with MPLINK and MPLIB User’s Guide. В 
технической документации на микроконтроллер приведено деталь-
ное описание инструкций микроконтроллера. 

 Сохраните файл с помощью пункта меню File > Save. 
 

2.5. Компиляция исходного файла 
 
Компиляция (преобразование текста программы в машинный 

код) осуществляется после запуска компилятора с помощью меню 
Project > Build All. После компиляции на экране появится окно ре-
зультатов. Так как в предпоследней строке текста приведенной выше 
программы была сделана ошибка, окно результатов будет содержать 
соответствующее сообщение о несуществующей метке “bug”. Двой-
ное нажатие левой кнопки манипулятора перенесет курсор на строку 
в исходном тексте программы, где была допущена ошибка. После 
исправления ошибок и повторного запуска компилятора на экране 
появится окно результатов с сообщением об успешной компиляции 
“Build completed successfully”. 

 
2.6. Запуск программы 

 
 Для инициализации симулятора выберите меню Debug > Run > 

Reset. Счетчик команд автоматически принимает значение 0x00. За-
тем с помощью меню Debug > Run > Step инициируйте выполнение 
команд, помеченных темной полосой. Практически все пункты меню 
имеют горячие клавиши на клавиатуре и в графическом меню. Вы-
бором пункта меню Debug > Run > Run или нажатием <F9> осущест-
вите запуск программы с текущей позиции счетчика команд. Оста-
новка программы произойдет после нажатия <F5> или Debug > Run 
> Halt, при этом указатель текущей инструкции примет первона-
чальный цвет, а информация в линейке состояния обновится. 
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2.7. Дополнительные окна 
 

MPLAB-ICD поддерживает большое количество способов кон-
троля выполнения программы как в режиме симулятора, так и при 
работе с аппаратными отладочными средствами. Для просмотра те-
кущего значения регистров выберите меню Window > File Registers, 
что позволит отслеживать в отдельном окне состояние регистров 
микроконтроллера. 

Для создания окна, отражающего отдельные (по выбору пользо-
вателя) регистры или биты, выберите пункт меню Window > Watch 
Window > New Watch Window. Если такое окно было создано ранее 
и сохранено на диске, выберите пункт меню Window > Watch Win-
dow > Load Watch Window. Укажите нужный файл, подтвердите 
выбор нажатием OK. На экране появится диалоговое окно добавле-
ния переменных (рис. 9). 

 
Рис. 9. Окно добавления переменных 

 
Введите в поле “Symbol:” новую переменную ‘c1’ и нажмите 

Add. После выбора всех необходимых регистров аналогичным обра-
зом нажмите Close. На экране появится окно с выбранными регист-
рами, состояние которых будет изменяться в процессе работы симу-
лятора. 

 Нажатием кнопки <F5> или Debug > Run > Halt остановите вы-
полнение программы. При нажатии левой кнопки манипулятора на 
строке с текстом ‘movlw 0x09’ появится диалоговое окно (рис. 10).  
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Рис. 10. Меню определения точек остановки 
 
Выберите пункт Break Point(s), указательная линия изменит 

свой цвет, указывая на точку остановки. Нажмите кнопку <F6> или 
Debug > Run > Reset для сброса, а затем <F9> для начала выполне-
ния программы. Выполнение программы будет прервано в точке ос-
тановки, при этом значение переменной ‘c1’ будет 0x00. Только по-
сле выполнения той операции, которая была обозначена как точка 
остановки, значение переменной ‘c1’ изменится на 0x09. 
 

3. ПОРЯДОК ВЫПОЛНЕНИЯ ЛАБОРАТОРНОЙ РАБОТЫ 
 
• Ознакомиться с теоретической частью лабораторной работы. 
• Запустить пакет MPLAB-IСD и, следуя рекомендациям п. 2, 

повторить все операции создания и отладки проекта. 
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ЛАБОРАТОРНАЯ РАБОТА №2 
 

ОРГАНИЗАЦИЯ ВВОДА-ВЫВОДА В МИКРОКОНТРОЛЛЕРАХ 
СЕМЕЙСТВА PIC16F87X 

 
Цель работы: Изучение работы портов параллельного ввода-

вывода микроконтроллеров семейства PIC16F87X, закрепление на-
выков работы в отладочной среде MPLAB с отладочным модулем 
MPLAB-ICD Demo Board. 

 
1. ПОРТЫ ВВОДА-ВЫВОДА МИКРОКОНТРОЛЛЕРОВ 

PIC16F87X 
 
Семейство PIC16F87X включает в себя приборы PIC16F873, 

PIC16F874, PIC16F876 и PIC16F877, которые имеют ряд отличий, 
заключающихся в разном числе линий ввода-вывода. PIC16F874 и 
PIC16F877 имеют 33 линии ввода-вывода (6-разрядный PORTA,  
8-разрядные PORTB, PORTC и PORTD и 3-разрядный PORTE), 
PIC16F873 управляет внешними устройствами по 22 линиям ввода-
вывода (6-разрядный PORTA и 8 разрядные PORTB и PORTC). Ос-
новное назначение линий ввода-вывода – программное управление 
передачей данных, синхронизации процессов, а также опроса со-
стояния внешних цепей и устройств. 

Некоторые линии портов ввода-вывода мультиплицированы с 
периферийными модулями микроконтроллеров. При работе таких 
модулей соответствующие линии портов не могут использоваться 
как универсальные линии. Дополнительную информацию смотрите в 
технической документации DS33023 “PICmicro Mid-Range Reference 
Manual”. 

 
1.1. Порт ввода-вывода PORTA 

 
PORTA – 6-разрядный универсальный порт ввода-вывода, 

имеющий вспомогательный регистр TRISA, позволяющий настраи-
вать отдельные линии как вход или выход. Запись логической ‘1’ в 
соответствующую (с тем же номером, что и отдельная линия) ячейку 
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этого регистра переводит соответствующий выходной буфер в 3-е 
(высокоимпедансное) состояние. Запись логического ‘0’ в те же 
ячейки регистра TRISA определяет соответствующие линии порта 
как выходы. При этом содержимое регистра PORTA передается на 
соответствующие выводы микроконтроллера. Очевидно, что для 
корректного опроса состояния отдельной линии порта при вводе ин-
формации соответствующая ячейка регистра TRISA должна перевес-
ти буфер этой линии в 3-е состояние. Содержимое ячейки с тем же 
номером регистра PORTA в этом случае игнорируется. Важно пом-
нить, что в микроконтроллерах семейства PIC16F87X линия RA4 
имеет триггер Шмидта на входе и открытый сток на выходе. Эта ли-
ния мультиплицирована с тактовым входом таймера/счетчика 
TOCK1. Все линии порта мультиплицированы с аналоговыми вхо-
дами АЦП и аналоговым входом источника опорного напряжения. 
Структурная схема цепей, управляющих работой порта, приведена 
на рис. 1.  

 
Рис.1. Структурная схема цепей управления линиями порта PORTA: 

а – линии RA<3:0> и RA<5>; б – линия RA<4> 
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После сброса по включению питания все вывода порта настраи-
ваются как аналоговые и при опросе дают логический ‘0’. Следую-
щий пример поясняет принцип настройки отдельных линий порта на 
ввод и вывод: 

 
BCF  STATUS, RP1 
BCF  STATUS, RP0  ;выбор банка 0 
CLRF  PORTA   ;запись во все ячейки PORTA  

         логических ‘0’ 
BSF  STATUS, RP0  ;выбор банка 1 
MOVLW 0x06    ;выключить компаратор 
MOVWF ADCON1   ;линии POTRA – цифровые вхо- 

         ды/выходы 
MOVLW 0xCF    
MOVWF TRISA   ;RA<3:0> - цифровые входы 
       ;RA<5:4> - цифровые выходы 
       ;TRISA<7:6> - при опросе всег- 

         да ‘0’ 
 

1.2. Порт ввода-вывода PORTB 
 
PORTB – 8-разрядный порт ввода-вывода, имеющий вспомога-

тельный регистр TRISB, функционально аналогичный регистру 
TRISA, определяющий направление передачи данных. Структурная 
схема цепей управления линиями порта PORTB приведена на рис. 2, 
из которого видно, что помимо возможности перехода в 3-е состоя-
ние линии этого порта поддерживают внутрисхемную “подтяжку”, 
что позволяет реализовать простой интерфейс обслуживания клавиа-
туры. Три вывода порта RB3, RB6 и RB7 мультиплицированы со 
схемой низковольтного программирования, поэтому в отладочных 
модулях, предполагающих многократное перепрограммирование 
микроконтроллера, эти выводы не используются для ввода-вывода. 
Линии RB<7:4>, настроенные на вход, могут генерировать прерыва-
ния по признаку изменения логического уровня на входе. 
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Рис.2. Структурная схема цепей управления линиями порта PORTB: 

а – линии RB<3:0> ; б – линия RB<7:4> 
 

1.3. Порт ввода-вывода PORTC 
 
PORTC – 8-разрядный порт ввода-вывода, имеющий вспомога-

тельный регистр TRISC, позволяющий настраивать отдельные линии 
как вход или выход. Запись логической ‘1’ в соответствующую (с 
тем же номером, что и отдельная линия) ячейку этого регистра пере-
водит соответствующий выходной буфер в 3-е (высокоимпедансное) 
состояние. Запись логического ‘0’ в те же ячейки регистра TRISC 
определяет соответствующие линии порта как выходы. При этом со-
держимое регистра PORTC передается на соответствующие выводы 
микроконтроллера. Выводы PORTC мультиплицированы с несколь-
кими периферийными модулями, при использовании которых необ-
ходимо соответствующим образом настраивать биты регистра 
TRISC. Некоторые периферийные модули модифицируют содержи-
мое TRISC, настраивая отдельные линии на ввод или вывод. Струк-
турная схема цепей управления линиями порта PORTC приведена на 
рис. 3. 
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Рис.3. Структурная схема цепей управления линиями порта PORTC: 

а – линии RC<7:5> и RC<2:0>; б – линия RC<4:3> 
 

1.4.  Порт ввода-вывода PORTD 

Регистры POTRD и TRISD не реализованы в микроконтроллерах 
PIC16F873 и PIC16F876. В микроконтроллерах PIC16F874 и 
PIC16F877 PORTD – 8-разрядный двунаправленный порт, направле-
ние передачи которого управляется с помощью TRISD аналогично, 
как и TRISA, TRISB и TRISC. PORTD может работать как  
8-разрядный микропроцессорный ведомый порт, если бит PSPMODE 
(TRISE <4>) установлен в ‘1’. Структурная схема цепей управления 
линиями порта PORTD приведена на рис. 4. 

1.5.  Порт ввода-вывода PORTE 

PORTE и TRISE не реализованы в микроконтроллерах 
PIC16F873 и PIC16F876. PORTE имеет три вывода индивидуально 
настраиваемых на ввод и вывод с помощью регистра TRISE. Если 
бит PSPMODE<4> установить в ‘1’, то линии RE0(-RD), RE1(-WR) и 
RE2(-CS) станут управляющими выводами ведомого параллельного 
порта PORTD. В этом режиме биты TRISE<2:0> должны быть уста-
новлены в ‘1’. Также в регистре ADCON1 необходимо настроить ли-
нии PORTE как цифровые. Выводы PORTE мультиплицированы с 
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аналоговыми входами АЦП. После сброса по включению питания 
выводы настраиваются как аналоговые входы, а их чтение дает ло-
гические ‘0’. Структурная схема цепей управления линиями порта 
PORTE приведена на рис. 5. 

 
Рис. 4. Структурная схема цепей управления линиями порта PORTD 

Рис.5. Структурная схема цепей управления линиями порта PORTE 
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Управление портом в режиме ввода-вывода и в режиме ведомого 
параллельного порта поясняет рис.6.  

 

 
 

Рис.6.  Назначение бит регистра TRISE 
 
Режим параллельного ведомого порта (PSP) не реализован в 

микроконтроллерах PIC16F873 и PIC16F876. PORTD работает как  
8-разрядный параллельный микропроцессорный порт, когда бит 
PSPMODE (TRISE<4>) установлен в ‘1’. В этом режиме данные чи-
таются и записываются в PORTD асинхронно, с помощью внешних 
сигналов –RD (RE0 – Inverced Read), -WR (RE1 – Inverced Write) и –
CS (RE2 – Inverced Chip Select). Принцип работы ведомого парал-
лельного порта поясняет рис. 7. 



 23

 
Рис.7. Принцип работы ведомого параллельного порта (PSP) 

 
2. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

 
• Ознакомиться с вводной частью лабораторной работы и схемой 

электрической принципиальной отладочного модуля MPLAB-ICD 
Demo Board. 

• Получить задание у преподавателя. 
• Запустить пакет MPLAB-ICD, создать и отладить проект в ре-

жиме симуляции выполнения программы микроконтроллера. 
• Выберите пункт Options > Development Mode, нажмите кнопку 

Tools для выбора инструментального средства и типа микрокон-
троллера, используемого в проекте (рис. 8).  

Выберите в окне Tools внутрисхемный отладчик MPLAB-ICD 
Debugger и микроконтроллер PIC16F877. Теперь, когда отладчик 
инициализирован, в линейке состояния включатся индикаторы 
“ICD” и “PIC16F877”, а на рабочем окне появится окно управления 
загрузчиком/программатором (рис. 9). 
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Рис.8. Окно выбора инструментального средства отладки 
 
 

 
 

Рис. 9. Окно управления загрузчиком/программатором 
 

Для ускорения внутрисхемной отладки следует до записи кода 
программы в поле возвращаемых значений регистров указать 
‘Minimum & Watch windows’. Откомпилированный исполняемый 
код программы будет загружен в память программ микроконтролле-
ра после нажатия кнопки ‘Program’. Когда загрузчик сообщит о за-
вершении процесса программирования в окне Status: Wait for User 
command счетчик команд автоматически принимает значение 0x00. 
Затем с помощью меню Debug > Run > Step (или клавишей F7) ини-
циируйте выполнение команд, помеченных темной полосой. Выбо-
ром пункта меню Debug > Run > Run или нажатием <F9> осущест-
вите запуск программы с текущей позиции счетчика команд. 
Остановка программы произойдет после нажатия <F5> или Debug > 
Run > Halt. 
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ЛАБОРАТОРНАЯ РАБОТА №3 
 

ИЗУЧЕНИЕ РАБОТЫ ВСТРОЕННОГО 10-БИТНОГО АЦП 
 
Цель работы: Изучение работы портов встроенного 10-битного 

АЦП микроконтроллеров семейства PIC16F87X, закрепление навы-
ков работы в отладочной среде MPLAB с отладочным модулем 
MPLAB-ICD Demo Board. 

 
1.  МОДУЛЬ АЦП МИКРОКОНТРОЛЛЕРОВ PIC16F87X 

 
Встроенный аналого-цифровой 10-разрядный преобразователь 

имеет пять каналов у микроконтроллеров PIC16F873 и PIC16F876 
(линии RA<5> и RA<3:0>) и восемь каналов у PIC16F874 и 
PIC16F877 (линии RE<2:0>, RA<5> и RA<3:0>). Напряжение, удер-
живаемое на линии соответствующего канала, преобразуется в 10-
битный цифровой двоичный код с шагом квантования по уровню, 
зависящим от опорных напряжений VREF+ и VREF-, и составляю-
щем (VREF+ и VREF-)/1024 В. В качестве источника опорных на-
пряжений VREF+ и VREF- могут использоваться напряжение пита-
ния контроллера (VDD), общий вывод (земля VSS), а также 
напряжения на выводах RA2 или RA3. Для управления работой АЦП 
используются регистры ADCON0 и  ADCON1, функции битовых по-
лей которых применительно к микроконтроллерам PIC16F874 и 
PIC16F877 приведены на рис 1 и 2. Принцип выбора отдельных ли-
ний для преобразования входных напряжений и для опоры поясняет-
ся рис. 3.  

Результаты аналого-цифрового преобразования сохраняются в 
регистрах ADRESH и ADRESL. Для корректной работы с модулем 
АЦП рекомендуется выполнять следующие операции: 

1. Настройка АЦП: 
− настроить линии портов PORTA и PORTE как аналоговые 

входы, выбрать линии опорного напряжения с помощью 
регистра ADCON1 (рис. 1); 

− выбрать входной канал АЦП с помощью регистра AD-
CON0 (рис. 2); 
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− запустить АЦП, установив флаг GO/DONE (ADCON0<2>). 
2. Разрешить прерывание от АЦП (только при использовании 

прерываний от АЦП): 
− сбросить флаг окончания преобразования ADIF (регистр 

PIR1<6>); 
− занести логическую ‘1’ в ADIE (регистр ADIE<6>); 
− занести логическую ‘1’ в PEIE (регистр INTCON<6>); 
− разрешить прерывания записью логической ‘1’ в GIE (ре-

гистр INTCON<7>). 
3. Обеспечить паузу не менее 20 мкс. 
4. Запустить преобразование, установив флаг GO/DONE (AD-

CON0<2>). 
5. Запустить цикл ожидания конца преобразования (по сбросу 

флага GO/DONE) или прерывания (если используется прерывание от 
АЦП). 

6. Считать результаты преобразования из регистров ADRESH и 
ADRESL. 

 

 
 

Рис. 1. Регистр управления АЦП ADCON0 
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Рис. 2. Регистр управления АЦП ADCON1 

 

 
Рис.3. Блок-схема АЦП микроконтроллеров PIC16F874 и PIC16F877 
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При циклическом опросе АЦП повторяются только пункты 2-3-
4-5-6 (только при использовании прерываний от АЦП) или 3-4-5-6. 
Формат чтения результатов преобразования из регистров ADRESH и 
ADRESL показан на рис. 4. 

 

 
 

Рис. 4. Формат чтения результатов аналого-цифрового преобразования 
 

Время 10-битного преобразования зависит от выбранного в ре-
гистре ADCON0 источника тактовых импульсов и коэффициента де-
ления тактовых импульсов микроконтроллера для формирования 
импульсов аналого-цифрового преобразования. Согласно рис. 1 для 
формирования импульсов преобразования TAD доступны четыре ва-
рианта: 

− TAD = 2 Tosc; 
− TAD = 8 Tosc; 
− TAD = 32 Tosc; 
− Встроенный RC-генератор. 
 
Здесь Tosc – период тактового сигнала микроконтроллера. Для 

10-битного преобразования необходимо время, равное 12 TAD. При 
этом для достоверного преобразования время TAD должно быть не 
менее 1,6 и не более 8 мкс. Период тактовых импульсов встроенного 
RC-генератора колеблется  в пределах 2 – 6 мкс. В табл. 1 приведены 
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значения TAD для различных тактовых частот микроконтроллера и 
коэффициентов деления Tad /Tosc. 

 
Таблица 1. Зависимость времени Tad от рабочей частоты микро-
контроллера (в затененных ячейках указаны Tad, выходящие за пре-
делы рекомендуемых значений) 

 

 
 

2. Порядок выполнения работы 
 
• Ознакомиться с вводной частью лабораторной работы и схе-

мой электрической принципиальной отладочного модуля 
MPLAB-ICD Demo Board (см. приложение 1). 

• Получить задание у преподавателя. 
• Запустить пакет MPLAB-ICD, создать и отладить проект в 

режиме симуляции выполнения программы микроконтролле-
ра. 

• Осуществить внутрисхемную отладку проекта, загрузив ис-
полняемый код программы в память команд микроконтрол-
лера. 
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ЛАБОРАТОРНАЯ РАБОТА №4 
 

ИЗУЧЕНИЕ РАБОТЫ ТАЙМЕРОВ И СИСТЕМЫ  
ПРЕРЫВАНИЙ 

 
Цель работы: Изучение работы таймеров TMR0, TMR1 и 

TMR2, а также системы прерываний микроконтроллеров семейства 
PIC16F87X, закрепление навыков работы в отладочной среде 
MPLAB с отладочным модулем MPLAB-ICD Demo Board. 

 
1.  МОДУЛЬ TMR0 МИКРОКОНТРОЛЛЕРОВ PIC16F87X 
 
TMR0 – 8-разрядный таймер/счетчик с 8-разрядным программи-

руемым предделителем, поддерживающий возможность чтения и за-
писи текущего значения, выбора внутреннего или внешнего источ-
ника тактового сигнала, выбора активного фронта внешнего 
тактового сигнала и вызова аппаратного прерывания по переполне-
нию. Блок-схема модуля TMR0 и общего с WDT предделителя при-
ведена на рис. 1. При сбросе бита TOCS (OPTION_REG<5>) TMR0 
работает как таймер, т.е. осуществляет подсчет машинных циклов 
микроконтроллера (следующих с частотой 1/(4×Tosc)). После записи 
текущего значения в TMR0 приращение счетчика запрещено два по-
следующих цикла. При установке бита TOCS, TMR0 работает как 
счетчик внешних тактовых импульсов, поступающих на вывод 
RA4/TOCK1. При этом активный фронт внешнего тактового сигнала 
(передний или задний) определяется битом TOSE (если OP-
TION_REG<4>=0, активным является передний фронт). Программно 
недоступный предделитель включается перед WDT или TMR0 в за-
висимости от состояния бита PSA (OPTION_REG<3>). 

Значения коэффициентов деления восьмиразрядного преддели-
теля определяются комбинацией, заносимой в битовые поля PS<2:0> 
регистра OPTION_REG согласно табл. 1. 
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Рис. 1. Блок-схема модуля TMR0 
 

Таблица 1. Коэффициенты деления 8-разрядного предделителя для 
модулей WDT и TMR0 
 

Значения PS<2:0> Коэффициент деления 
для TMR0 

Коэффициент деления 
для WDT 

000 1:2 1:1 
001 1:4 1:2 
010 1:8 1:4 
011 1:16 1:8 
100 1:32 1:16 
101 1:64 1:32 
110 1:128 1:64 
111 1:256 1:128 
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2.  МОДУЛЬ TMR1 МИКРОКОНТРОЛЛЕРОВ PIC16F87X 
 
TMR1 – 16-разрядный таймер/счетчик, состоящий из двух  

8-разрядных регистров (TMR1H и TMR1L), доступных для чтения и 
записи. Инкрементирование счетчика происходит с каждым такто-
вым импульсом, источником которого, в режиме таймера, является 
предделитель (делитель частоты машинных циклов), либо внешний 
источник, подключенный к выводу RC0 (в режиме таймера). Модуль 
TMR1 также поддерживает возможность подсчета импульсов, гене-
рируемых встроенным RC-генератором, пассивные элементы кото-
рого подключаются к выводам RC0 – RC1. Блок-схема модуля TMR1 
приведена на рис. 2. 

 

 
 

Рис. 2. Блок-схема модуля TMR1 
 
Для управления работой модуля TMR1 используется регистр 

T1CON, функции битовых полей которого применительно к микро-
контроллерам PIC16F874 и PIC16F877 приведены на рис 3. 

После переполнения 16-разрядного счетчика (максимальное зна-
чение FFFFh) флаг прерывания TMR1IF в регистре PIR1<0> уста-
навливается в ‘1’, а счетчик сбрасывается в 0000h. 
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Рис. 3. Регистр управления режимами работы модуля TMR1 
 

3.  МОДУЛЬ TMR2 МИКРОКОНТРОЛЛЕРОВ PIC16F87X 
 
TMR2 – 8-разрядный таймер с программируемым предделите-

лем, выходным делителем и 8-разрядным регистром периода PR2, 
позволяющим организовать программно управляемый ШИМ-контур. 
Регистры, связанные с работой TMR2, доступны для записи и чтения 
и сбрасываются в ‘0’ при любом виде сброса. Блок-схема модуля 
TMR1 приведена на рис. 4. 

Входной тактовый сигнал (1/(4×Tosc)) поступает через предде-
литель с программируемым коэффициентом деления (1:1, 1:4 или 
1:16), определяемый битами T2CKPS1 и T2CKPS0 (T2CON<1:0>). 
TMR2 инкрементируется с каждым машинным циклом от 00h до 
значения, записанного в PR2, после чего сбрасывается в 00h. После 
сброса значение регистра PR2 равно FFh. 
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Рис. 4. Блок-схема модуля TMR2 
 

Сигнал переполнения TMR2 проходит через выходной 4-
разрядный делитель с программируемым коэффициентом деления 
(от 1:1 до 1:16) для установки флага TMR2IF в регистре PIR1<1>. 
Для уменьшения энергопотребления таймер TMR2 может быть вы-
ключен сбросом бита TMR2ON (T2CON<2>) в ‘0’. Функции битовых 
полей регистра T2CON приведены на рис. 5. 

 

 
 

Рис. 5. Регистр управления режимами работы модуля TMR1 
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4.  СИСТЕМА ПРЕРЫВАНИЙ МИКРОКОНТРОЛЛЕРОВ  
СЕМЕЙСТВА PIC16F87X 

 
Микроконтроллеры семейства PIC16F87X имеют 14 источников 

прерываний. Регистр INTCON содержит флаги отдельных прерыва-
ний, биты их разрешения и бит глобального разрешения прерыва-
ний. Если бит GIE (INTCON<7>) установлен в ‘1’, то все прерывания 
разрешены. Этот бит после сброса установлен в ‘0’. При возникно-
вении прерывания поднимается соответствующий флаг в регистре 
INTCON, и, если прерывание разрешено, вызывается процедура об-
работки соответствующего прерывания и сбрасывается флаг GIE, 
запрещая вызов других прерываний. По окончании процедуры обра-
ботки прерывания после выполнения команды REFIE этот флаг воз-
вращается в ‘1’. При переходе на процедуру обработки прерывания 
текущее значение из счетчика команд заносится в стек, а в счетчик 
команд загружается единый вектор 0004h. Определение источника 
прерываний осуществляется программно посредством проверки фла-
гов, поэтому в процессе настройки прерываний эти флаги следует 
сбросить с помощью соответствующих битовых полей в регистрах 
INTCON, PIE1 и PIE2. Следует помнить, что флаги прерываний ус-
танавливаются независимо от состояния бита GIE. Функции битовых 
полей регистров INTCON, PIE1 и PIE2 приведены на рис. 6, 7, 8. 

 
5.  Порядок выполнения работы 

 
• Ознакомиться с вводной частью лабораторной работы и схе-

мой электрической принципиальной отладочного модуля MPLAB-
ICD Demo Board (см. приложение 1). 

• Получить задание у преподавателя. 
• Запустить пакет MPLAB-ICD, создать и отладить проект в 

режиме симуляции выполнения программы микроконтроллера. 
• Осуществить внутрисхемную отладку проекта, загрузив ис-

полняемый код программы в память команд микроконтроллера. 
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Рис. 6. Регистр управления прерываниями INTCON 
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Рис.  7. Регистр разрешения/запрещения прерываний от функциональных 
модулей PIE1 
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Рис. 6.  Регистр разрешения/запрещения прерываний от функциональных 
модулей PIE2 
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Приложение 1  
 

Схема электрическая принципиальная  
отладочного модуля MPLAB-ICD Demo Board 
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Окончание прил. 1
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Приложение 2 
 

Область регистров специальных функций 
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Продолжение прил. 2 
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Окончание прил. 2 
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